
Unity ist eine Multiplattform-Spie-
leumgebung, entwickelt seit 2005
von der dänischen Firma Unity

Technologies. Mittlerweile ist das Frame-
work in der Version 4.3.2 verfügbar und
gilt als eine der populärsten Spiele-En -
gines weltweit. Wie kaum eine andere
Engine unterstützt Unity den Ansatz der
„Demokratisierung der Spieleentwick-
lung“. Ziel des Herstellers ist es, mög-
lichst vielen Nutzern ein Werkzeug zur
Entwicklung interaktiver 3D-Inhalte zur
Verfügung zu stellen. Dazu bietet Unity
auf hoher Abstraktionsebene die notwen-
dige Funktion an, unterstützt viele Hard-
wareplattformen (Desktop, Konsolen,
mobile Geräte) und garantiert eine für
freie Entwickler bezahlbare Preis- und
Lizenzpolitik.

Dadurch ist die Game Engine sowohl
bei professionellen Entwicklungsstudios
als auch bei freien Entwicklern und
Hobbyprogrammierern sehr beliebt. Hoch-
schulen, an denen mittlerweile spezielle
Studiengänge im Bereich Digitale Me-
dien und Spieleentwicklung stark nach-
gefragt werden, nutzen Unity ebenfalls.
Inzwischen gibt es mehr als zwei Millio-
nen registrierte Nutzer (Quelle: http://
unity3d.com/company/public-relations/,
siehe „Alle Links“), mindestens 400ˇ000
Entwickler sind laut Hersteller monatlich
aktiv und der Unity Webplayer ist 225
Millionen Mal installiert worden.

Einfacher Einstieg 
und komplexe Funktionen
Ein Grund dafür ist sicherlich der einfa-
che Einstieg in die 3D-Welt durch eine in-
tegrierte Entwicklungsumgebung mit gut
benutzbaren Werkzeugen, die der Anwen-
der über spezielle Plug-ins wie Playmaker
sogar vollständig visuell ohne Kenntnis
einer Programmiersprache einsetzen
kann. Gleichzeitig lassen sich in Unity
komplexe Funktionen wie Augmented
Reality, fortgeschrittene Render-Verfahren
oder aufwendige Simulationsberechnun-
gen integrieren und als einfach wiederzu-
verwendende Komponenten zur Verfü-
gung stellen. 

Wie sich die Arbeit mit Unity konkret
gestaltet, soll ein dreiteiliges Tutorial zei-
gen. Es entwickelt Schritt für Schritt eine
kleine spielerische Applikation. Dieser ers-
te Teil stellt zunächst die grundlegenden
Konzepte der Game Engine vor. Danach
folgt anhand detaillierter Beschreibungen
die Entwicklung des Jump-and-Run-
Spiels, das die zwei folgenden Teile kon-
tinuierlich ausbauen. Auf grundlegende
Aspekte der Computergrafik kann dieser
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Unity-Tutorial: Erste Schritte mit der Game Engine
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Ein Computerspiel sollte vor allem Spaß machen, aber auch
einfach zu bedienen und grafisch anspruchsvoll sein. Wer ein
solches Spiel entwickeln will, stellt bald fest, dass er Hilfe be-
nötigt. Die bietet unter anderem die Game Engine Unity. Aller-
dings ist sie selbst so komplex, dass sorgfältige Einarbeitung
erforderlich ist. Ein dreiteiliges Tutorial zeigt, was es bei der
Entwicklung eines einfachen Spiels alles zu beachten gilt.
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Dreiteiler dabei nicht eingehen. Dazu sei
auf weiterführende Literatur verwiesen.
Grundlegende Programmierkenntnisse in
C# werden ebenfalls vorausgesetzt. 

Neben den genannten technischen Vor-
teilen erklärt die Lizenz- und Preispolitik
der Dänen den hohen Marktanteil von
Unity. In der „Indie-Version“ für Desktop-
Plattformen ist die Game Engine kosten-
los, lässt sich aber trotzdem für kommer-
zielle Projekte nutzen. Die Pro-Version,
die viele zusätzliche Funktionen wie 3D-
Texturen, Effekte für Full Screen Postpro-
cessing, Level of Detail, weiche Schatten,
3D-Texturen und Videostreaming ermög-
licht, kostet für die gängigen PC-Plattfor-
men (Windows, Mac OS, Linux) 1500
US-$. Die für größere Projekte wichtige
Unterstützung lokaler und räumlich ge-
trennt arbeitender Teams durch Asset
Cache Server und Versionierungskon-
trolle bietet der Hersteller für 500 US-$
pro Arbeitsplatz an.

Hoher Marktanteil 
auch durch Preispolitik
Unity-Projekte lassen sich typischerweise
ohne größere Hürden für mobile Endge-
räte bereitstellen, eine Pro-Lizenz für An-
droid, iOS oder BlackBerry kostet eben-
falls jeweils 1500 US-$. Verzichtet man
auf die Pro-Funktionen und das Strea-
ming von Assets auf die Endgeräte sind
die Basic-Varianten für die genannten
mobilen Plattformen wie die „Indie“-Ver-
sion kostenlos. Windows Phone Pro ist
sogar in der Pro-Version enthalten.

Erheblich teurer hingegen gestaltet
sich zum Teil die Entwicklung für Spiel-
konsolen, da deren Hersteller bisher hohe
Anforderungen an Entwickler stellen. Mit
dem Erscheinen neuer Konsolengenera-
tionen wie WiiˇU, Xbox One und PS4 än-
dert sich diese Situation teilweise, und
Nintendo, Microsoft und Sony werben
verstärkt um einzelne Entwickler und
kleine Studios.

Registrierte Wii-U-Entwickler erhalten
eine spezielle Version von Unity Pro für
die Konsole kostenlos. Microsoft bewirbt
sein Independent Developer Programm
für die Xbox One ebenfalls mit einer frei-
en Unity-Pro-Lizenz.

Neuartige Ein- und Ausgabegeräte wie
Oculus Rift, Leap Motion, Sixense Razer/
Stem oder Virtuix Omni bieten eine An-
bindung an Unity, damit 3D-Entwick ler
ihre Produkte schnell akzeptieren. Ein
weiterer Grund für die Beliebtheit die ser
Entwicklungsumgebung ist der Asset
 Store , ein digitaler Marktplatz für unter-
schiedliche Unity-Inhalte. Viele Entwick-
ler stellen hier ihre Lösungen für spezielle
Anforderungen vor oder bieten einen ein-
fachen Zugriff auf erstellte 3D-Modelle,
Animationen oder Texturen. Die Inhalte
dieser Assets reichen von komplexen 3D-
Szenen (beispielsweise Big Environment
Pack) über KI-Algorithmen zum Finden

von Wegen (etwa A* Pathfinding Project)
bis zu komplexen Werkzeugen/Plug-ins
für MotionCapturing mit Kinect, visuelle
Spieleentwicklung (beispielsweise Play-
maker) oder HDR image-based lighting
(etwa Skyshop).

Durch einen schnellen Einkauf der
meist zwischen 10 und 100 US-$ teuren
Assets kann man eine Menge Zeit sparen,
indem man die existierenden Inhalte
nutzt. Dabei erweist sich die integrierte
Nutzerbewertung als bewährtes Werk-
zeug, um die Spreu vom Weizen zu tren-
nen. Wer trotz guten Produkts keine aus-
reichende Dokumentation oder gar eine
Demoszene zur Verfügung stellt, nur sel-
ten neue Versionen seiner Software an-
bietet oder nicht auf Anfragen der Käufer
antwortet, erhält schnell eine kritische
Bemerkung der anspruchsvollen Commu-
nity. Ein späterer Teil dieses Tutorials
wird eine Übersicht ausgewählter, aus
Sicht der Autoren lohnender Produkte im
Asset Store geben.

Immer auf der 
Höhe der Zeit bleiben
Unity Technologies entwickelt die Game
Engine ständig weiter und integriert re-
gelmäßig neue oder verbesserte Techni-
ken. In der im August 2013 erschienenen
Versionˇ4 waren dies vor allem das neu-
artige Animationssystem Mecanim und
fortgeschrittene Render- und Shading-
Techniken sowie die Unterstützung für

iX 2/2014 37

⬛-TRACT
⚫ Unity ist eine weitverbreitete Game Engine, die sich unter anderem für 

anspruchsvolle 3D-Spiele eignet und in der „Indie“-Version frei verfügbar ist.

⚫ Der Hersteller entwickelt die Engine kontinuierlich weiter und integriert fort -
geschrittene Render- und Shading-Techniken ebenso wie aktuelle Animations -
systeme.

⚫ Für das Editieren von Quellcode – unterstützt werden C# sowie zwei Script -
sprachen – wird die Entwicklungsumgebung MonoDevelop mitgeliefert, 
andere Editoren lassen sich aber bei Bedarf einbinden.

Kochrezept für die Entwicklung mit Unity
Die folgende Auflistung der wichtigsten
Schritte bei der Erstellung eines Unity-Spiels
sollen einen kurzen Überblick darüber geben,
wie Entwickler vorgehen. Dabei sind einzelne
Schritte im Verlauf der meist iterativen Ent-
wicklung auch mehrmals durchführbar.

Vorab ist es aus Sicht der Autoren sinnvoll,
auf der Website des Herstellers die zu ver-
schiedenen Themen umfangreich zur Verfü-
gung gestellten Informationen zu lesen.
Empfehlenswert ist zunächst die direkte
Übersicht zu Unity, die einige Beispiele ent-
hält (siehe „Alle Links“).

Anschließend sollte man sich in den Work-
flow einlesen und sich bei Interesse weiterfüh-
rende Informationen zu den verschiedenen
Werkzeugen verschaffen. Eine umfangreiche
Referenz ist das Unity-Benutzerhandbuch.

Wer nun selbst in die 3D-Entwicklung unter
Unity einsteigen will, muss Unity zunächst
laden und installieren. Danach hilft bei jedem
neuen Projekt ein „Kochrezept“:

–ˇErzeuge ein neues Unity-Projekt mit dem
Project Wizard.
–ˇImportiere die notwendigen Assets wie 3D-
Modelle, Texturen, Klänge et cetera.
–ˇErzeuge für jedes Spielelevel eine eigene
3D-Szene.
–ˇPlatziere für jede Szene die passenden As-
sets als Szenenobjekte.
–ˇStelle die Parameter der Main Camera pas-
send ein und positioniere sie.
–ˇFüge Lichtobjekte hinzu beziehungsweise
konfiguriere das Umgebungslicht.
–ˇWeise den Objekten passende Materialien
und weitere Eigenschaften zu, beispielsweise
Physik, Animationen oder Kollisionserken-
nung.
–ˇSchreibe notwendige Scripts und weise sie
den Objekten zu.
–ˇTeste den Ablauf der Applikation im Editor.
–ˇPubliziere die fertige Applikation auf der
gewünschten Plattform.
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Linux. Die Version 4.3, das Ende 2013
erschienene kleinere Update, weist neben
vielen Detailverbesserungen zwei zentra-
le Neuerungen auf.

Verbesserter Umgang mit Animationen:
Seit der Versionˇ4 bietet Unity mit Meca-
nim ein mächtiges Animationssystem, das
alle notwendigen Arbeiten direkt in der
Game Engine ermöglicht. Dabei lassen
sich importierte Animationen auf andere
3D-Figuren anwenden (retargeting). Kom-
plexe Animationen erstellt der Anwender
in der Regel einzeln in externen Werkzeu-
gen als Keyframe-Animation oder nimmt
sie mit MotionCapturing-Systemen direkt
auf und importiert sie anschließend in eine
Game Engine. Unity 4.3 bietet mit Blend
Trees und Zustandsautomaten die Mög-
lichkeit, einzelne Clips miteinander zu
kombinieren und so eine große Anzahl un-

terschiedlicher Animationen zu erstellen.
Über spezielle Plug-ins im Asset Store wie
Mixamo hat der Anwender zudem Zugriff
auf eine riesige Bibliothek vordefinierter
Bewegungen und kann ein 3D-Face-Tra-
cking in Echtzeit durchführen.

2D Engine included: Bisher war Unity
als reine 3D-Engine konzipiert. Es gab
aber seit Jahren Projekte, die reine 2D-
Applikationen waren, und Produkte im
Asset Store (etwa 2DToolkit), die eine
einfache Erstellung von 2D-Inhalten er-
möglichen, sind Verkaufsschlager. Unity
hat diese Ideen nun in der Version 4.3
selbst als neuen 2D-Workflow umgesetzt
und ermöglicht sprite-basierte 2D-Ani-
mationen sowie die effiziente Kombina-
tion von 3D- und 2D-Inhalten.

Im Prinzip stellt Unity einen 3D-Le-
vel-Editor zur Verfügung, in dem der

Benutzer existierende Objekte impor-
tiert, in einer Szene arrangiert und ein-
zelne Elemente mit weiteren Eigen-
schaften versieht. Dieses Vorgehen ist
vergleichbar mit der Arbeitsweise gän-
giger 3D-Werkzeuge wie Maya oder 3ds
Max, auch wenn Unity nur wenige Mo-
dellierungs- oder Texturierungsfunktio-
nen bereitstellt. Der Schwerpunkt des
Werkzeugs liegt auf der Entwicklung
komplexer Scripts sowie der Konfigura-
tion einzelner Elemente in der Szene. 

Kurz erklärt: Grundkonzepte
der Unity Engine
Eine Unity-Applikation besteht aus fol-
genden Elementen:

Project: Eine zu entwickelnde Unity-
Anwendung (etwa ein Spiel) wird durch
den Project Wizard in einem eigenen Pro-
jekt organisiert und in einem speziellen
Verzeichnis gespeichert.

Scene Graph: Eine Unity-Anwen-
dung besteht aus einer Anzahl verschie-
dener Szenen (vgl. Spiele-Level), die der
Entwickler einzeln in der Engine erstel-
len kann. Eine Szene besteht aus einer
Menge von Elementen (GameObjects),
die hierarchisch in einem Szenengraphen
 angeordnet sind. Bei Objekten, die in ei-
ner Eltern-Kind-Beziehung stehen (Unity
nennt das Parenting), vererben Objekte in
höheren Ebenen („Eltern“) ihre Position
und Orientierungsinformationen an da-
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Beim ersten
Start von Unity
erscheint der
Project Wizard
(Abb.ˇ1).

Die Benutzeroberfläche der Game Engine präsentiert dem Entwickler die wichtigsten Informationen auf einen Blick.
Individuelle Anpassungen sind möglich (Abb.ˇ2).
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runterliegende „Kind“-Objekte. Der Sze-
nengraph ist in der 3D-Computergrafik
ein mächtiges Konzept zur Strukturierung
von Szenen und erscheint in der Unity-
Umgebung in einem eigenen Fenster.

GameObjects: Sie sind das zentrale
Konzept in Unity, da jedes benötigte Ele-
ment in einer Anwendung als GameOb-
ject definiert ist. Zunächst handelt es sich
dabei nur um einen Container ohne ei-
gentliche Funktion. Aus programmier-
technischer Sicht stellt er die Basisklasse
aller Entitäten in Unity dar.

Components: Die benötigte Funktion
der GameObjects stellen Komponenten
bereit. Je nach Objekt können verschiede-
ne Komponenten – etwa Audioquellen,
Animationen, Lichter, Texturen oder Par-
tikelsysteme – in einem GameObject exis-
tieren. Eine der wichtigsten Komponenten
ist Transform, da jedes GameObject erst
durch sie seine Position und Orientierung
in der 3D-Szene definiert und diese an an-
dere GameObjects im Szenengraphen
weitergibt. Jedes GameObject besitzt eine
solche Transform-Komponente.

Scripting: Das Verhalten der Game-
Objects beschreiben die in Unity vorde-
finierten Komponenten, die bereits recht
mächtig sind. Für darüber hinausgehende
Funktionen nutzt man den speziellen
Komponententyp Script. Er unterstützt
die Programmierung in C#, UnityScript
(eine an JavaScript angelehnten Sprache)
sowie Boo (eine .NET-Sprache mit Py-
thon-ähnlicher Syntax). Da ein Script ei-
ne Komponente ist, muss man es nach
seiner Erstellung mit einem GameObject
verbinden, damit es aktiv wird.

Prefabs: Prefabs sind ein weiteres
wichtiges Konzept in Unity, um existie-
rende Lösungen wiederzuverwenden.
Dabei handelt es sich um einfach zu er-
stellende spezielle GameObjects, die
mehrfach wiederverwendbar sind und im
Prinzip das Original für eine Reihe ge-
klonter Objekte darstellen. Instanziiert
man ein solches Prefab, erzeugt man ei-
ne Kopie, die man wie ein normales
Game Object in seiner Szene verwendet.
Alle Instanzen (oder besser Kopien) sind
dabei mit dem ursprünglichen Prefab-
Objekt verknüpft. Änderungen am Origi-
nal leitet Unity automatisch an alle In-
stanzen weiter.

Assets: Unter Assets verstehen Ent-
wickler normalerweise alle digitalen Me-
dieninhalte wie Grafiken, 3D-Modelle,
Musikdateien et cetera. Wie bei anderen
Game Engines ist in Unity ein effizienter
und flexibler Asset Workflow besonders
wichtig, da Entwickler viele Medieninhal-
te mit externen Werkzeugen erstellen und
importieren. Unity bietet hier den direkten

Zugriff auf viele Industriestandards für
3D-Modellierung, Texturen und Audio-
und Videodateien. Ein Vorteil ist dabei,
dass die Engine auf die meisten Assets na-
tiv zugreift. Verändert man mit dem exter-
nen Werkzeug den Inhalt, sieht man dies
direkt in der Applikation. Neben reinen
Medieninhalten betrachtet Unity auch ex-
terne Prefabs als Assets. Unitys Asset
 Store ist ein umfangreicher Marktplatz für
solche Prefabs sowie klassische Assets.

Auf geht’s: Erste Schritte 
in der Engine
Beim ersten Start von Unity erscheint
der Project Wizard (Abbildungˇ1). Hier
kann der Anwender entweder bereits er-
stellte Projekte aus einer Liste auswählen
(im Tab „Open Project“) oder neue er-
stellen („Create New Project“). Im zwei-
ten Fall wählt man zunächst ein Projekt-
verzeichnis aus (unter Windows über den
Menüpunkt „Browseˇ…“, auf anderen
Plattformen kann es in der Menüführung
leichte Unterschiede geben). Weiterhin
besteht die Möglichkeit, Assets aus Unitys
Standardrepertoire zu importieren. Dazu
gehören vor allem verschiedene Effekte
(sowohl als Shader als auch als Postpro-
cessing) und nützliche Scripts.

Das Tutorial-Beispiel startet zunächst
mit einem leeren Projekt (passend be-
nannt als iXUnityTutorial). Auf die Aus-
wahl zusätzlicher Assets verzichtet es.
Nach dem Erstellen eines Projekts landet
der Benutzer im Default-Layout der
 Benutzeroberfläche (Abbildungˇ2). Die
wichtigsten Bereiche sind
–ˇdie Szenen-Hierarchie, die alle Game-
Objects in einer Art Szenengraph darstellt
(linke Spalte),
–ˇdie Rendering-Bereiche (mittlere Spal-
te)  für das Editieren und Manipulieren
der Szene (SceneView, Tab Scene), wie
es aus den üblichen 3D-Modellierungs-
werkzeugen bekannt ist, sowie dem
 GameView (Tab Game, mittlere Spalte),
–ˇder Inspector, in dem ein gewähltes
 GameObject mit all seinen Komponenten
dargestellt und konfiguriert wird (rechte
Spalte),
–ˇder Projekt-Explorer (ProjectView) mit
allen Scripts, Materialien, Prefabs und
sonstigen Dateien, die der Anwender
durch Import oder Kopieren im Unterord-
ner Assets des Projektordners abgelegt  hat
(Tab Project), und die Konsole, auf der die
Engine Debug-Informationen, Warnungen
und Fehler ausgibt.
–ˇDie Toolbar enthält fünf Kontroll -
elemente, mit denen der Entwickler be-
stimmte Elemente steuern kann: Trans-
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form Tools (SceneView), Transform
 Gizmo Toggles (SceneView Gizmos),
Ablauf kontrollen (GameView), Layer-
Aus wahl (SceneView) sowie Layout-
Auswahl  (Editor).

Layout der Oberfläche 
individuell anpassen
Das Default-Layout der Unity-Oberflä-
che kann der Benutzer individuell anpas-
sen, indem er die Bereiche in ihrer Größe
ändert oder über den Tab verschiebt.
Auch ein Abdocken der Fenster ist mög-
lich, sodass er sie beliebig auf dem Bild-
schirm platzieren kann. Über den Menü-
punkt „Window -> Layouts“ oder über
die Toolbar-Schaltfläche „Layouts“ kann
er andere Layout-Presets laden oder eige-
ne speichern. Hier muss jeder seine eige-
nen bevorzugten Ansichten herausfinden,
manchmal ist es sinnvoll, sowohl den
Szenen-Editor als auch das Game-Win -
dow gleichzeitig zu sehen (zum Beispiel
„2 by 3“) oder aber alle Seitenansichten
(Top, Side, Front in orthografischer Per-
spektive) im Blick zu haben, um Objekte
besser ausrichten zu können.

Ist das richtige Layout eingestellt (die
Autoren preferieren ein abgewandeltes
„Wide“-Layout, da dort ein großer Sze-

nen-Editor zur Verfügung steht), kann
man mit der Bearbeitung einer kleinen
Szene beginnen, um die einzelnen Ober-
flächen ein wenig besser kennenzulernen.

In jeder neuen Szene erzeugt Unity
automatisch ein Kameraobjekt, das als
Main Camera betitelt ist und mit dem
sich das Tutorial zunächst noch nicht be-
fasst. Über den Menüpunkt „GameObject
-> Create Other -> Cube“ erzeugt das
Beispiel ein GameObject mit einer Wür-
felgeometrie. Es erscheint als ausgewähl-
tes Objekt direkt im Inspector, der Sze-
nenhierarchie und im Szenen-Editor. Im
Inspector wird zunächst die Komponente
Transform genauer betrachtet, die weite-
ren Komponenten werden im späteren
Verlauf des Tutorials vorgestellt.

Jedes GameObject besitzt eine Trans-
form-Komponente, die im Wesentlichen
Funktionen und Variablen zur Verfügung
stellt, um ein Objekt im Raum zu positio-
nieren und in seiner Größe zu ändern. Der
Inspector stellt den Positionsvektor, die
Eulerwinkel für die Rotation sowie den
Skalierungsvektor im lokalen Koordina-
tensystem des Objekts zur Bearbeitung zur
Verfügung (die globale Transformation er-
gibt sich durch die Verkettung einzelner
Objekt-Transformationen in der Szenen-
hierarchie, Stichwort: Szenengraph). In-
tern verwendet Unity jedoch Quaternionen
zur Darstellung von Rotation, da Euler-
winkel nicht immer eindeutig sind.

Die Werte im Inspector lassen sich
entweder per Tastatur oder durch ein Zie-
hen der über dem Feld-Label gedrückten
linken Maustaste nach links/unten oder
rechts/oben ändern.

Zusätzlich dazu zeigt der Szenen-Edi-
tor an der Objektposition einen Manipu-
lator, mit dem man die Transformation
des Objekts direkt in der Szene ändern

kann. Diese visuellen Hilfssysteme im
Szenen-Editor und im GameView heißen
in der Unity-Terminologie Gizmos.

Es gibt drei Formen des Manipulators
(siehe „Manipulatoren“), die entweder im
lokalen oder im globalen Koordinatensys-
tem eines Objekts agieren. In der Toolbar
(Gizmo Display Toggles) befindet sich die
Schaltfläche „Local“ zum Umschalten des
Manipulators zwischen lokalem und glo-
balem Koordinatensystem. Die einzelnen
Manipulatoren kann der Anwender entwe-
der über die Manipulatorschaltflächen
(Transform Toggles) oder über die Tas -
tatur anwählen. Bei gedrückter Strg-Taste
kann er ein Snapping aktivieren, das er
über den Menüpunkt „Edit -> Snap Set-
tingsˇ…“ einstellen kann.

Die genaue Ausrichtung von Objekten
erfordert, dass man sie aus verschiedenen
Positionen betrachten kann. Dazu bietet
Unity mehrere Navigationstechniken.
Zum einen gibt es in der oberen rechten
Ecke des Szenen-Editors das Scene Giz-
mo (Abbildungˇ3), das sowohl die aktu-
elle Rotation der Szenenkamera visuali-
siert, als auch eine Änderung der Kamera
bewirken kann, indem diese an den ein-
zelnen Achsen im globalen Koordinaten-
system ausgerichtet wird. Außerdem ist
eine Änderung der Projektionsart zwi-
schen perspektivisch und orthogonal (oh-
ne perspektivische Verzerrung) mit die-
sem Gizmo möglich.

Perspektiven und 
Navigation im Szenen-Editor 
Zum anderen ist eine Navigation mit
Maus und Tastatur die wohl am häufigs-
ten genutzte Technik (siehe „Navigation
…“). Wer dieses Tutorial aktiv weiter
verfolgen will, sollte die verschiedenen
Navigationstechniken nun ausprobieren
und verinnerlichen, um im Weiteren si-
cher damit umgehen zu können.

Im nächsten Schritt wird der erstellte
Würfel gewählt und ein Reset der Trans-
formation durchgeführt. Das geschieht,
indem man rechts auf die Komponente
Transform im Inspector drückt und den
Punkt „Reset“ auswählt. Der Würfel liegt
nun im Nullpunkt der Szene. Jetzt wird er
(über Manipulator oder Inspector) ein
Stück auf der x-Achse bewegt (zwei bis
drei Einheiten).

Anschließend wird eine Kugel erstellt
(„GameObject -> Create Other ->   Sphe re“)
und über die Szenenhierarchie auf den
Würfel gezogen. Die Position der Kugel
im Szenen-Editor bleibt gleich, jedoch
hat sich die lokale Position im Inspector
aufgrund der erstellten Hierarchie verän-
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Translation

oder Taste „W“

Änderung der Position eines Objekts entlang 
der Achsen (Pfeile) beziehungsweise entlang der 
zwischen den Hauptachsen aufgespannten Ebenen
(Flächen im Ursprung)

Rotation

oder Taste „E“

Änderung der Objektausrichtung (ein Ring pro 
Achse, äußerer Ring zur Rotation um die Kamera -
achse, 2. Ring von außen zur freien Rotation um den
Up- beziehungsweise Side-Vektor der Editorkamera)

Skalierung

oder Taste „R“

Größenänderung entlang der einzelnen Achsen 
(Würfel am Ende der Achsen) oder uniform in alle
Richtungen (Würfel im Ursprung)

Manipulatoren

Das Scene Giszmo
hilft beim 
Einstellen der 
Perspektive
(Abb.ˇ3).
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dert. Lässt man den Würfel nun um die y-
Achse rotieren, rotiert auch die Kugel, al-
lerdings erfolgt die Rotation nicht um den
Manipulator, der sich im Mittelpunkt der
Geometrien befindet, sondern um den Pi-
vot-Punkt des Würfels. (In Modellie-
rungsprogrammen kann man den Pivot-
Punkt eines Objektes definieren. Er
entspricht dem Dreh- und Angelpunkt
und ist der Ausgangspunkt für alle fol-
genden Transformationen.) Über die
Toolbox kann ein Klick auf die Schaltflä-
che „Center“ den Manipulator in den Pi-
vot-Punkt verschieben, was die Rotation
verständlicher macht. Durch die Erstel-
lung einer Hierarchie bleibt die relative
Position der Kugel zum Würfel immer
gleich.

Die Entstehung 
eines interaktiven Spiels 
Nachdem die wichtigsten Grundlagen
zum Umgang mit der Unity-Benutzer-
oberfläche nun erläutert sind, geht es wei-
ter zum nächsten Teil. Die Erstellung ei-
nes kleinen interaktiven Spiels soll
weitere Einblicke in die Unity-Welt ge-
währen. Das Ziel ist ein kleines Platt-
form-Spiel, in dem eine Figur, die der
Benutzer aus einer Third-Person-Perspek-
tive sieht, Gegenstände sammeln kann.
Dazu muss sie Hindernisse überwinden
und darf nicht zu tief fallen oder zu viel
Zeit verstreichen lassen. GUI-Elemente
sollen zusätzlich Start- und End-Screens
einblenden.

Die beiden nächsten Teile des Tutori-
als bauen das Spiel weiter aus. Wer die
einzelnen Schritte nachvollzieht, sollte
am Ende eigenständig mit Unity umge-
hen können. Natürlich können drei Zeit-
schriftenartikel nicht alle Gebiete dieser
Game Engine behandeln, aber immerhin

in die wichtigsten Grundlagen einführen.
Dazu zählen Scripting, Character Con-
trol, Camera Control, Kollisionserken-
nung und -verarbeitung, Audio, GUI, ein-
fache Animation und Physik.

Für Texturen und Sounds greift das
Tutorial vorwiegend auf freie Assets zu.
Bei Bedarf und je nach eigenen Fähigkei-
ten kann man sie natürlich auch selbst er-
stellen. Zu Anfang behandelt das Tutorial
möglichst alle Einzelheiten im Detail, im
späteren Verlauf werden die Instruktionen
reduziert.

Der erste Schritt ist die Erstellung einer
neuen Szene, der der Menüpunkt „Game-
Object -> Create Other -> Plane“ einen
Boden hinzufügt. Ein Klick mit der rech-
ten Maustaste auf „Transform -> Reset“,
bewirkt, dass diese Plane im Ursprung
liegt. Standardmäßig hat sie eine Seiten-
länge von zehn Einheiten. Für ausrei-
chend Platz wird sie in alle Richtungen
mit dem Faktor 1000 skaliert, was ein we-
nig zu groß ist, aber im weiteren Verlauf
Vorteile bringen wird. Da sich die Plane
im Spielverlauf nicht bewegen soll, kann
man rechts oben im Inspector die Option
„Static“ anwählen, damit man Optimie-
rungen der Szene durchführen kann
(Stichworte: Batching, Occlusion Cul-
ling). Die Plane – oder besser die Rende-
ring-Komponente (MeshRenderer) – er-
hält das Unity-Standardmaterial Default-
Diffuse, dessen Farbe weiß ist.

Als Nächstes geht es an die Erstellung
eines neuen Materials. Dazu wird im
ProjectView ein neuer Ordner für Mate-
rialien angelegt (man sollte ein Projekt
von Anfang an gut strukturieren, indem
verschiedene Arten von Assets in ihren
eigenen Ordnern abgelegt werden). Dies
kann durch einen Rechtsklick auf den
Ordner Assets in der Baumstruktur des
ProjectView erfolgen. Dadurch öffnet
sich ein Kontextmenü, in dem der obers-
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Move

1. linke Maustaste (bei gewähltem Hand-Tool, kein Manipulator aktiv); 
2. Alt-Taste und mittlere Maustaste (Manipulator kann aktiv sein)

Orbit

Alt-Taste und linke Maustaste (Hand-Tool oder Manipulator aktiv)

Zoom

1. Strg-Taste und linke Maustaste (bei aktivem Hand-Tool); 
2. Mausrad; 
3. Alt-Taste und rechte Maustaste (Manipulator kann aktiv sein)

Focus Mit der Taste „F“ kann der Anwender das gewählte Objekt in der Bildmitte 
zentrieren und zur vollen Größe aufziehen. Dabei muss die Maus sich über dem
Szenen-Editor befinden.

Walking Mit den Pfeiltasten lässt sich die Szenenkamera vorwärts oder seitwärts ohne 
Änderung der Ausrichtung über das Gitternetz bewegen. Shift beschleunigt 
die Bewegung.

Flythrough Bei gedrückter rechter Maustaste kann der Anwender ähnlich wie in einem 
Ego-Shooter mit den Tasten „W“, „A“, „S“, „D“, „Q“ und „E“ (vorwärts, seitwärts
links, hoch, rückwärts, seitwärts rechts und runter) entlang der Kameraaus richtung
navigieren. Shift beschleunigt die Bewegung.

Navigation mit Maus und Tastatur
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te Punkt Create ausgewählt wird. Hier
bietet sich die Möglichkeit, Scripts, Ma-
terialien, Shader und andere Assets anzu-
legen. Die Beispielanwendung wählt zu-
nächst den Punkt Folder. Wie in einem
normalen Dateimanager entsteht im
rechten Teil des ProjectView ein Ordner,
der direkt in Materials umbenannt wer-
den kann. Ein Doppelklick wechselt in
diesen Ordner, und auf die gleiche Art
(oder mit einem Rechtsklick in den rech-
ten Teil des ProjectView) wird ein neues
Material erstellt, das die Bezeichnung
Floor erhält.

Dieses Material erscheint direkt im
Inspector. Hier kann man zunächst einen
Shader-Typ auswählen, das Beispiel
bleibt jedoch beim voreingestellten Sha-
der namens Diffuse, der eine diffuse Re-
flexion des Lichts bewirkt (nach Lam-
bert). Über den Punkt Main Color kann
der Benutzer die Farbe über einen Klick
auf das Farbfeld (es öffnet sich ein Farb-
dialog) oder über den Klick auf die Pi-
pette (Colorpicker; der nächste Klick
wählt die Farbe unter dem Maus-Cursor
aus) einstellen. Das Beispiel wählt zu-
nächst ein sattes Grau. Per Dragˇ&ˇDrop
kann der Anwender das erstellte Materi-
al auf die Plane im SceneView oder in
der Szenenhierachie ziehen. Im Prinzip
lassen sich alle Assets per Dragˇ&ˇDrop
aus dem ProjectView in der Szene plat-
zieren.

Eine weitere Komponente auf dem
Boden ist der MeshCollider, der es er-
möglicht, Kollisionen mit der Plane zu
erkennen. Ein MeshCollider bildet die
Kollisionsgeometrie anhand des zugrun-
de liegende Körpers, hier eine Ebene,
und ist die präziseste, jedoch rechenin-
tensivste Version eines Collider. Nur
durch die Aktivierung des Flags Convex
kann ein MeshCollider auch mit einem
anderen MeshCollider kollidieren. Ne-
ben jeder Komponente im Inspector ist
ein kleines Buch mit einem Fragezeichen
abgebildet, über das der Benutzer direkt
die Dokumentationsseiten von Unity auf-
rufen kann.

Nach den ersten Änderungen in der
Szene sollte man speichern. Dazu wird
unter Assets ein Ordner Scenes erstellt, in
dem die Szene gespeichert wird. Regel-
mäßiges Speichern erspart viel Frust,
wenn Unity einmal abstürzen sollte.

Der statischen Szene 
Leben einhauchen
Nachdem das Spielfeld hergerichtet ist,
kann es an die Erstellung der Figur gehen.
Der Spieler soll sie per Maus- und Tasta-
tureingaben in einer Third-Person-Per-
spektive durch die Szene navigieren. Hier
kommt ein essenzieller Teil der Game En-
gine zum Tragen: das Scripting. Nur da-

mit kann der Entwickler einer statischen
Szene Leben und Logik einhauchen.

Doch zunächst erzeugt man wiederum
die nötigen Geometrien. Als Erstes wird
ein neues GameObject – in diesem Fall
eine Capsule – samt Material erstellt, et-
wa einem schönen Grün, und passend be-
nannt. Diesen Player positioniert man
nun so, dass er knapp über der Plane
steht (y >1), und fügt über die Schaltflä-
che „Add Component -> Physics“ die
Komponente Character Controller hinzu. 

Der Character Controller ist eine spe-
zielle Form des Collider (oder auch des
Capsule Collider, da dieselbe Geometrie
zugrunde liegt) speziell für Spielfiguren.
Hier kann der Entwickler definieren, wie
tief der Collider in einen anderen eindrin-
gen kann (Skin Width, etwa um ein Fest-
stecken zu vermeiden) und welche Stei-
gungen (Slope Limit) oder Stufen (Step
Offset) die Figur überwinden kann.

Nun ist es an der Zeit, ein erstes
Script zu erstellen. Dazu wird unter As-
sets zunächst ein Ordner Scripts angelegt
und dort über „Rechtsklick -> Create“
ein C#-Script hinzugefügt, das den Na-
men ThirdPersonController erhält und
das direkt auf den Player gezogen wird.
Durch einen Doppelklick auf das Script
im ProjectView oder durch einen Rechts-
klick auf das Script im Inspector und an-
schließende Auswahl von „Edit Script“
öffnet sich die Entwicklungsumgebung
MonoDevelop.

Steuern über 
die Input-Klasse
In dieser IDE können Entwickler alle
Codes in Unity bearbeiten, seien es
Scripts oder Shader. Natürlich lassen sich
auch andere Editoren verwenden, von
einfachen Texteditoren bis hin zu anderen
Entwicklungsumgebungen wie Visual
Studio. Die gewünschte Einstellung kann
unter Windows über „Edit -> Preferences
-> External Tools -> External Script Edi-
tor“ erfolgen.

Ein Unity-Script ist abgeleitet von der
Klasse MonoBehavior und nach dem Er-
stellen bereits mit den Funktionen Start
(zum Initialisieren) und Update (zum Ak-
tualisieren des Zustands) ausgestattet. Als
Erstes implementiert das Tutorialbeispiel
eine einfache Steuerung, indem es die
Eingabeklasse Input verwendet. Mit ihr
lassen sich Maus, Tastatur und definier-
bare Achsen (Axis, etwa Vertical, Hori-
zontal) und Knöpfe (Buttons, etwa Fire1,
Jump) abfragen. 

Über den InputManager („Edit -> Pro-
ject Settings -> Input“, Abbildungˇ4) kann
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Bearbeiten (bei selektiertem GameObject)
Strg+D Duplizieren
Strg+C/Strg+V/
Strg+X

Kopieren/Einfügen/
Ausschneiden

Entfernen Löschen
Bearbeiten (allgemein)
F Objekt ins Bild einpassen 

(zentrieren)
Strg+A alles auswählen
Ablaufkontrolle
Strg+P Play (Szene starten)
Strg+Shift+P Pause
Strg+Alt+P Einzelschritt
Dateiverwaltung
Strg+N neue Szene
Strg+O Szene öffnen
Strg+S Szene speichern
Strg+Shift+S Szene speichern als …
Manipulation
Strg+linke
Maustaste

Snapping

V Vertex Snapping
Q Pan View (Handtool)
W Translation
E Rotation
R Skalierung
Z Wechsel zwischen Pivot 

und Center
X Wechsel zwischen Lokal 

und Global

Tastaturkürzel unter Windows

Über den InputManager kann der 
Entwickler die vor definierten Achsen 
und Buttons indivi duell einstellen
(Abb.ˇ4).
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der Entwickler alle vordefinierten Achsen
und Buttons individuell einstellen sowie
eigene definieren. Dies kann man direkt
tun, indem man die Achse Horizontal
markiert und per Strg-D dupliziert (alter-
nativ über die Maus „Duplicate Array
Element“). Die neue Achse erhält den
Namen Strafe, und die Tasten Q und E
werden als Negative beziehungsweise
Positive Button definiert. Die alternativen
Buttons (Alt …) werden gelöscht.

Die Update-Funktion des Script fragt
zunächst die horizontale, vertikale und
die seitwärtige (strafe) Achse ab, die sich
auch über die Pfeiltasten oder die Tasten
WASD steuern lässt. Dazu kann man die
Member-Funktionen GetAxis (geglättet
mit einem Tiefpassfilter, keine harten
Sprünge) und GetAxisRaw (ungefiltert)
nutzen. (Listingˇ1 zeigt die Update-Funk-
tion des Script mit einem Vergleich der
beiden Werte.) Die Funktion Debug.Log
gibt sie auf die Unity-Konsole aus.

Nach dem Start der in Listingˇ2 zu se-
henden Szene über den Play-Button
wechselt die Ansicht zum GameView,
wobei das Drücken der Tasten W oder S
(der Fokus muss im GameView sein) ei-
ne entsprechende Ausgabe bewirkt. In
der Statusleiste sieht der Entwickler die
letzte Ausgabe der Konsole, alternativ
kann er die ganze Konsole über einen
Tab im Bereich des ProjectView öffnen.
Diese beiden Werte dienen dazu, den
CharacterController vorwärts laufen be-
ziehungsweise um seine y-Achse rotie-
ren zu lassen. Dazu muss das Script die
Komponente CharacterController zur
Verfügung stellen. Dies geschieht über
die Funktion GetComponent der Klasse
MonoBehavior (entweder als generische
Funktion oder mit dem Komponentenna-
men als Parameter). Um sicherzugehen,
dass es eine solche Komponente auf dem
GameObject gibt, sollte das Script zu
Beginn das Attribut RequireComponent
nutzen. Damit kann ein GameObject eine
Komponente nicht mehr einfach löschen.
Sie wird mit dem Script automatisch hin-
zugefügt.

Die Funktionen Move oder SimpleMove,
die sich in ihrer Komplexität unterschei-
den, steuern die Bewegung des Charac-
terController. SimpleMove wendet auto-
matisch eine Gravitationskraft an und
unterdrückt jegliche Anteile in Richtung
der y-Achse. Für die Beispielanwendung
genügt das zunächst, im späteren Verlauf
kommen ein paar Änderungen hinzu und
es wird auf die Methode Move gewechselt.
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1  void Update () {
2    float forward = Input.GetAxis("Vertical");  
3    float forwardRaw = Input.GetAxisRaw("Vertical");  
4    Debug.Log("gefiltert: " + forward + "\tgefiltert: " + forwardRaw);
5  }

Listing 1: Update-Funktion mit Vergleich zwischen gefilterter und ungefilterter Eingabe

6  using UnityEngine;
7  using System.Collections;
8  
9  [RequireComponent(typeof(CharacterController))]               
10  public class ThirdPersonController : MonoBehaviour {
11   
12     CharacterController characterController;  
13     public float rotationSpeed = 60.0f;       
14     public float walkingSpeed = 8.0f;         
15     // Use this for initialization
16     void Start () {
17       characterController = this.GetComponent<CharacterController>();     
18     }
19   
20     // Update is called once per frame
21     void Update () {
22       float forward = Input.GetAxis("Vertical");
23       float rotate = Input.GetAxis("Horizontal"); 
24       float strafe = Input.GetAxis("Strafe");       
25 
26       transform.Rotate(Vector3.up, rotate * rotationSpeed * Time.deltaTime);    
27       Vector3 direction = this.transform.right * strafe + this.transform.forward * forward; 
28       characterController.SimpleMove(direction * walkingSpeed);   
29     }
30   }

Listing 2: Erste Version des ThirdPersonController-Skripts

Tutorialinhalt
Teil 1:  Aufbau einer einfachen Szene und

Interaktion mit ihr
Teil 2:   Spiellogik, erweiterte Interaktion,

GUI
Teil 3:   Aufbau eines kompletten Levels

(Plattformen, Platzieren von Gegen-
ständen, Münzen), Integration aller
Teile, Spielablauf mit mehreren 
Szenen (Startbildschirm), Effekte
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Über die Methode Rotate der Trans-
form-Komponente erfolgt die Drehung
der Spielefigur. Zur Steuerung der Ge-
schwindigkeit werden zwei Variablen (als
public) angelegt, eine für die Bewegungs-
geschwindigkeit (walkingSpeed) und eine
für die Drehgeschwindigkeit (rotation -
Speed). Sie erhalten einen vernünftigen
default-Wert (soll m/s beziehungsweise
grad/s entsprechen). Öffentliche Varia-
blen zeigt der Inspector an, und der Ent-
wickler kann sie dort direkt ändern.

Als Parameter erhält Rotate die Rota-
tionsachse (Vector3.up für die globale  y-
Achse) sowie den Rotationswinkel, der
sich aus der Eingabeachse, der Dreh -
geschwindigkeit sowie der Zeit seit dem
letzten Aufruf der Update-Funktion
(Time. deltaTime) zusammensetzt, damit
eine von der Frame-Rate unabhängige
Bewegung entsteht (eine geschwindig-
keitsabhängige Weg- beziehungsweise
Winkeländerung ist immer bezogen auf
die betrachtete Zeit, Abbildungˇ5).

Wo Licht ist, 
ist auch Schatten 
Die Richtung, in der sich die Figur bewe-
gen soll, berechnet sich aus der Addition
der mit der jeweiligen Eingabe (Wert
zwischen 0 und 1) gewichteten, aktuellen
Vorwärts- beziehungsweise Seitwärts -
ausrichtung (this.transform.forward be -
ziehungsweise this.transform.right) der
Transform-Komponente. Ihre Speiche-
rung erfolgt in der Vector3-Variablen.
Diese Richtung wird wie bei der Rotation

mit der Bewegungsgeschwindigkeit mul-
tipliziert und an die Funktion SimpleMove
übergeben. Da diese bereits die zeitlichen
Abhängigkeiten berücksichtigt, muss sie
nicht mehr explizit berechnet werden.

Beim Start der Szene sieht der Betrach-
ter sie aus Sicht der Main Camera. Alles
scheint ein wenig zu dunkel zu sein, offen-
sichtlich fehlt noch ein Licht. Im Szenen-
Editor verwendet Unity standardmäßig ei-
ne automatische Beleuchtung, solange
eine Anwendung nicht explizit ein Licht
erzeugt hat.

Der Hintergrund ist nun blau, was in
den Kameraeinstellungen (Inspector)
über Background geändert werden kann.
Steuert der Spieler die Figur nun über
WASD, bewegt sie selbst sich zwar, aber
die Kamera bleibt an Ort und Stelle.
Auch eine Rückmeldung über eine Dre-
hung der Figur fehlt, die Kapsel sieht von
allen Seiten gleich aus. Da der Boden
ebenfalls keine Änderungen aufweist,
wird eine Navigation schwierig.

Doch da kann Abhilfe geschaffen wer-
den. Zunächst zum Licht: Es wird ein
 Directional Light erzeugt (wie gehabt,
„Game Object -> Create Other -> Direc -
tional Light“), da es am besten für die Ge-
samtbeleuchtung der Szene geeignet ist.
Es hat keine Bindung an einen Ort, nur
der Einfallswinkel ist ausschlaggebend.
Diesen kann man über die Rotation so
wählen, dass eine gute Ausleuchtung der
Figur gewährleistet ist. Später kann man
weitere Lichter hinzufügen, um die Szene
besser auszuleuchten.

Licht ist auch ein dramaturgisches Ge-
staltungsmittel, das Spieleentwickler an
bestimmten Stellen bewusst stark oder nur
schwach einsetzen. Zu viele Lichtquellen
sind rechenintensiv, deshalb kann man sie
teilweise in eine statische Umgebung hi-
neinrendern (Light Baking), um die Per-
formance zu steigern. Zwischendurch
kann man immer wieder das Spiel starten,
um die Änderungen zu begutachten.

Für eine bessere räumliche Wahrneh-
mung ist die Verwendung von Schatten

wichtig. Da Unity ab Version 4.2 Echt-
zeit-Schatten für ein direktionales Licht
berechnen kann, nutzt das Tutorial diese
Möglichkeit, um dem Spiel einen besse-
ren räumlichen Eindruck zu verpassen.
Die Game Engine unterscheidet zwi-
schen harten Schatten (Hard Shadows)
und solchen mit einem weichen Verlauf
im Anfangsbereich (Soft Shadows). Die
freie Version erlaubt nur harte Schatten.

Bei selektiertem Licht kann der Ent-
wickler unter Shadow Type den Schatten-
typ auswählen. Die Stärke und Auflö-
sung kann er hier ebenfalls verändern.
Im Szenen-Editor ist der Schatten sofort
zu sehen.

Das grüne Männchen 
bekommt Profil
Als nächstes soll die Figur ein wenig
Struktur bekommen, damit auch Drehun-
gen besser zu sehen sind. Dazu wird zu-
nächst eine weitere Capsule erzeugt, die
dieselbe Farbe erhält wie der Player und
in der Szenenhierarchie auf den Player
gezogen wird. Das neue Objekt wird so
positioniert und skaliert, dass es einem
Arm entsprechen könnte (vor allem am
Anfang ist es für Einsteiger mit wenig
Erfahrung wichtig, einiges an Positionen
und Skalierungen auszuprobieren, damit
sie ein Gefühl für die Modellierung be-
kommen). Sinnvollerweise benennt man
das neue Objekt gleich passend. Durch
die Tastenkombination Strg+D (oder über
den Punkt „Duplicate“ des Kontextme-
nüs) kann man es duplizieren und an-
schließend an die Position des anderen
Arms setzen (einfach ein Minus vor den
x-Wert setzen). Bitte auch hier die Na-
mensänderung nicht vergessen.

Mittlerweile könnte man meinen, hier
entstehe ein kleines Android-Männchen.
Damit es nicht zu ungewollten Kollisionen
und Störungen des CharakterController
kommt, werden die automatisch hinzuge-
fügten Collider entfernt. Damit der Player
ein wenig mehr Persönlichkeit bekommt,
wird als Nächstes ein Gesicht konstruiert,
allerdings ohne eine komplizierte Textu-
rierung des ganzen Körpers. Dazu erzeugt
die Beispielanwendung eine Plane mit
dem Namen Face (oder ähnlich), die
ebenfalls in der Hierarchie unter den Play-
er gezogen wird. Durch geschickte Trans-
formation sollte man sie so verändern,
dass sie die Größe eines Gesichts hat und
an der passenden Stelle sitzt (in Richtung
des blauen Pfeils der Figur, forward, am
Manipulator). Sollte die Ebene nach einer
Rotation nicht mehr zu sehen sein, liegt
das daran, dass die Rückseite in Richtung
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Beziehung zwischen Geschwindigkeit 
und Weg: Wegänderung ist gleich 
Geschwindigkeit multipliziert mit der 
Zeitveränderung, analog bei der Winkel-
änderung (Abb.ˇ5).

Nicht länger ein 
Android-Männchen:
Die fertige Spielefigur
hat ein Gesicht be -
kommen (Abb.ˇ6).
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Kamera zeigt und aufgrund des Backface
Culling nicht gerendert wird.

Die Textur für das Gesicht findet man
im Internet. eine Bildersuche nach „free
smiley“ liefert viele nette Gesichter, die
für das Projekt infrage kommen, bei-
spielsweise unter http://www.freestock
photos.biz/stockphoto/16633 (am besten
ist eine Public Domain oder Creative-
Commons-Lizenz). Es bietet sich eine
ganze Smiley-Palette an, da eventuell ei-
ne Änderung des Gesichtsausdrucks wäh-
rend des Spiels möglich sein soll. Die
Autoren haben sich für die SVG-Version
entschieden, aus der sie mit Inkscape ei-
nen Smiley als PNG-Datei (128ˇxˇ128 Pi-
xel) exportiert haben. Das unterhalb von
Assets gespeicherte Bild wird wie gehabt
per Dragˇ&ˇDrop auf die Plane für das
Gesicht gezogen (Abbildung 6).

Die Kamera 
richtig positionieren
Nachdem die Figur ein wenig mehr Profil
erhalten hat, kann es darangehen, dass die
Kamera dem grünen Männchen bei einer
Rotation folgt. Doch zunächst sei noch
angemerkt, dass sich die Bewegung der
Figur über den Inspector feinjustieren
lässt, indem man die einzelnen Geschwin-
digkeiten für Rotation beziehungsweise
Translation ändern; so lässt sich über die
Erhöhung der Rotationsgeschwindigkeit
zum Beispiel ein kleinerer Wendekreis
einstellen. 

Der erste einfache Schritt ist ein Script
mit dem Namen ThirdPersonCamera-
Controller, das die öffentlichen Variablen
target vom Typ Transform sowie distance
und height vom Typ float definiert. Die
Start-Funktion fragt ab, ob das target ge-
setzt ist und deaktiviert das Script im Feh-

lerfall. Da zunächst alle Objekte die Zeit
haben sollen, ihren Zustand zu ändern,
nutzt das Script für die Änderung der Ka-
meraposition die Funktion LateUpdate.
Hier werden die Position der Kamera auf
die Position des Ziels geändert und ein
Offset addiert, das aus der Höhe und dem
Abstand im lokalen Koordinatensystem
resultiert (Listingˇ3, Zeile 51). Dazu dient
die Funktion Transform.TransformDi-
rection, die einen Vektor in das Koordina-
tensystem des GameObject transformiert.
Anschließend bewirkt die Funktion
Transform.LookAt, dass die Kamera ge-
nau auf die Figur gerichtet ist.

Nach dem erneuten Starten des Spiels
kann der Anwender die Figur navigieren
und sieht sie immer von hinten. Das Drü-
cken der rechten Maustaste soll nun die
Kamera um die Spielfigur rotieren lassen.
Dazu muss die Mausposition beim ersten
Drücken gespeichert und im Anschluss ei-
ne Differenz aus aktueller und letzter
Mausposition berechnet werden. Eine Va-
riable rotationOffset vom Typ Quaternion
(zur Darstellung von Rotationen) wird an-
hand der Differenz in der x-Achse und ei-
ner Rotationsgeschwindigkeit wie schon
bei der Bewegung des CharacterControl-
ler geändert (durch Multiplikation mit der
Änderung in Form einer AngleAxis-Ro-
tation). Zusätzlich beeinflusst der Rota-
tions-Offset die Position der Kamera
(Multiplikation lokaler Position mit dem
Rotations-Offset, Listingˇ4).

Nun lässt sich die Figur bewegen und
von allen Seiten betrachten. Über die
mittlere Maustaste sollte noch ein Reset
des Rotations-Offset erfolgen (mit Qua-
ternion.idendity gleichsetzen). Alle ver-
wendeten Dateien sind einzeln sowie als
Unity-Package mit komplettem Projekt
über den iX-Listingservice verfügbar (sie-
he „Alle Links“).

Ausblick
Dieser erste Tutorialteil hat die Grundla-
gen von Unity und dessen Benutzerober-
fläche vorgestellt. Er sollte klar gemacht
haben, wie man eine einfache Szene auf-
baut und mit ihr interagieren kann. Mani-
pulationen der Transformationsmatrizen
sollten keine großen Mühe mehr bereiten.

Der nächste Teil bearbeitet die bisher
erstellten Assets weiter und erklärt, wie die
Spielfigur Gegenstände einsammeln kann,
wie sich Audiosequenzen einfügen sowie
fortgeschrittene Scripts und Spiellogiken
integrieren lassen. Außerdem werden die
ersten Elemente eines Spielmenüs und ei-
ner Statusanzeige eingebaut. (ka)
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31 using UnityEngine;
32 using System.Collections;
33 
34 public class ThirdPersonCameraController : MonoBehaviour {
35 
36   public Transform target;
37   public float distance;
38   public float height;
39   
40   // Use this for initialization
41   void Start () {
42     if(target == null)
43     {
44       this.enabled = false;
45     }
46   }
47   
48   // Update is called once per frame
49   void LateUpdate () {
50     
51     this.transform.position = target.position + 

target.transform.TransformDirection(new Vector3(0,height,-distance));
52     this.transform.LookAt(target);        
53   }
54 }

Listing 3: Script ThirdPersonCameraController

55 public float rotationSpeed  = 1.0f;
56 Quaternion rotationOffset = Quaternion.identity;
57 Vector3 lastMousePosition;
58 
59 // Update is called once per frame
60 void LateUpdate () {
61   if (Input.GetMouseButtonDown(1))
62   {
63     lastMousePosition = Input.mousePosition;
64   }
65   else if (Input.GetMouseButton(1))
66   {
67     Vector3 delta = Input.mousePosition - lastMousePosition; 
68     rotationOffset *= Quaternion.AngleAxis(delta.x * 

rotationSpeed * Time.deltaTime, Vector3.up);       
69     lastMousePosition = Input.mousePosition;
70   }
71   this.transform.position = target.position + 
72     target.transform.TransformDirection(rotationOffset *  

new Vector3(0,height,-distance));
73   this.transform.LookAt(target);        
74 }

Listing 4: Erweiterung von ThirdPersonCameraController
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